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W H AT  I S  « M Y  WAT C H E S »  ?  

• «My Watches» manages all your watches (wristwatches, grandfather clocks, pocket watches, etc.). 
Features: 
• Any number of pictures can be added to each watch 
• Picture search via Google® and DuckDuckGo for the selected watch 
• Pictures can be inserted using drag and drop or copy and paste 
• Pictures can be imported via an iOS device 
• Any number of additional pictures can be added to each watch 
• Any number of attachments (invoices, operating instructions, etc.) can be added to each watch 
• Favorites list 
• Wish list 
• List of watches sold 
• Trash feature 
• Selected text can be searched via Chrono24® 
• Selected text can be searched via Google® 
• Selected text can be searched via Ebay® 
• Automatic calculation of the value of the entire watch collection or individual categories with 

• Purchase price 
• Current value 
• Price increase 

• The increase in value is highlighted in color (plus = green, minus = red) 
• Graphical evaluation of the increase in value for 

• All watches 
• Own watches 
• Sold watches 

• The evaluation can be saved as PDF, SVG, PNG, JPG, or GIF 
• Display of the average total increase in value 
• Total increase in value is calculated for 

• All watches 
• Own watches 
• Sold watches 

• The following data is calculated 
• Total purchase price 
• Total current price / sales price 
• Increase in value 
• Increase in value in % 

• All values can be shared via the macOS sharing services 
• Preview of all pictures and attachments 
• Automatic saving of all changes 
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• Printing of all or selected watches as a list 
• Printing of all or selected watches with all details 
• Export all entries as CSV or Excel® XLSX file 
• Unlimited number of freely definable categories 
• Management of categories 
• Unlimited number of freely definable manufacturers 
• Management of manufacturers 

• Manufacturer details 
• Manufacturer name 
• Contact person 
• Country 
• Postal code 
• City 
• Street 
• Phone 
• Email 
• URL 
• Comments 

• Service management 
•   Description 
•   Last service 
•   Next service 
•   Costs 
•   Workshop 
•   Work performed 
•   Attachments 
• Backup of all data (database, pictures, and attachments) to any internal or external data carrier, cloud 

drive, or freely selectable folder 
• Data recovery 
• Unlimited number of entries with the following details: 

• BASIC DATA 
• Designation 
• Manufacturer 
• Category 
• Condition 
• Reference number 
• Storage location / location 
• Country 
• Year of manufacture 
• Weight 
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• Product URL 
• Last customer service 
• Next customer service 
• Total customer service costs 

• PURCHASE 
• Purchase price 
• Current price 
• Automatic calculation of increase in value 
• Date of purchase 
• Shop / store 
• Store / supplier URL 

• PACKAGING / SCOPE 
• Watch only 
• With original box 
• With original papers 
• Complete set 

• FEATURES 
• Feature 
• Additional feature 
• Repetition 
• Chronograph 
• Tourbillon 

• BODY 
• Material 
• Color 
• Shape 
• Number 
• Glass 
• Size / Diameter 
• Height 
• Water resistance 
• Bezel material 

• CLOCK FACE 
• Material 
• Color 
• Shape 
• Digits 

• BRACELET 
• Material 
• Color 
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• Bridge width 
• Length 
• Width 
• Thickness 
• Closure 
• Closure width 
• Closure material 

• CLOCKWORK 
• Clockwork 
• Movement number 
• Date / Moon phase 
• Power reserve 
• Number of jewels 
• Caliber / Movement 
• Winding 

• SOLD 
• Sale price 
• Date 
• Sold to Person 
• Store 
• Store URL 

• COMMENTS 
• Comments 

• TAGs 
• Any number of freely definable TAGs 
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A P P L I C AT I O N  S TA R T  

After launching “My Watches,” the main window will open. The database and all attachments for “My 
Watches” are stored in the directory “~/Library/Containers/de.pps4me.MyWatches/Data/Library/
Application Support/My Watches.” 
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F U N K T I O N S W E I S E  

The main window is divided into the following areas: 

1. Toolbar menu with various features 

2. Selection menu with categories 

3. List of entries 

4. Line for application information 

5. Totals of the entries displayed (total price, current value, and increase in value of all watches or the 
selected category) 
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P R O G R A M M  DA R S T E L L U N G  

The selection menu and the list of all entries can be moved horizontally or vertically.i  

The details can be hidden via the toolbar menu or the “Display => Hide details” menu. 
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For a faster overview of the details, you can scroll the area to the beginning or to the end with one click. 
To do this, open the context menu with the right mouse button. 

The details can also be scrolled using the keyboard: 

Start ↖︎ => Scrolls to the top 

End ↘︎ => Scrolls to the bottom 

Page Down ⇟ => Scrolls one page down 

Page Up ⇞ => Scrolls one page up 

Selection menu 
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The numbers behind the groups and subgroups mean the following:

My watches My watches

 Total number of watches  Total number of watches

All watches All watches

 Total number of watches  Total number of watches

My own watches My own watches

 Total number of unsold watches  Total number of unsold watches

Sold watches Sold watches

 Total number of sold watches  Total number of sold watches

Favorites Favorites

 Number of favorites  Number of favorites

Wish list Wish list

 Number of entries in the wish list  Number of entries in the wish list

Categories Categories

 Number of assigned categories  Number of assigned categories

Each category Each category

 Number of watches in this category  Number of watches in this category

Manufacturers Manufacturers
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The number of watches is always calculated without the entries in the trash. 

Double-clicking expands a group and displays the subgroups it contains. Double-clicking on an 
expanded group closes the group. The elements of the tree structure can also be selected using the 
keyboard, via the arrow keys (left, right, up, and down).

Country Number of assigned countries

Any country Number of clocks for this country

TAGs Number of assigned TAGs

Any TAGs Number of watches per TAG

Trash Number of watches in trash

↑ Up

↓ Down

← Collapse group/subgroup

→ Expand group/subgroup

© 2015-2025 CIMSoft, @pps4Me            Table of Contents Page  of 13 58



My Watches Release 25.1.0

A D D  E N T RY  

To add a new entry, select Menu => "File => Add entry", or select "Add entry" from the context menu. 

In the details section you can enter the values, select the category and the manufacturer. If a new 
category or manufacturer is needed, you can enter it here directly. A new category or manufacturer can 
be added via the category or manufacturer administration. All changes are automatically saved when 
you leave the respective field or pop-up menu. 
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E D I T  E N T RY  

With a click on an entry in the list of watches you see the details of the selected entry. In this view you 
can change all available values. 
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Select a category and manufacturer from the drop-down menu. Set the “Add to favorites” switch to ‘On’ 
or “Off.” In the “Description” field, you can change the title of the entry and add a comment if desired. 
All changes are automatically saved when you leave the respective field or pop-up menu. 

A D D  P I C T U R E S  T O  A N  E N T RY  

With "Drag and Drop" you can drag and drop a product photo into the displayed frame "Drop image 
here". As soon as an image has been inserted, it will automatically be saved to the selected watch.  

If you don't have a picture for your tool, you can search for a picture with a mouse click. Select "Search 
picture..." from the context menu. 
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Select a picture from the search results and drag it directly from Safari into the “Drop picture here” area. 
Once a picture is in the “Drop picture here” area, it can be activated with a single click. This is indicated 
by a frame. You can now preview the picture and all attachments by pressing the space bar. 

© 2015-2025 CIMSoft, @pps4Me            Table of Contents Page  of 17 58



My Watches Release 25.1.0

A product photo can also be added using “copy and paste.” To do this, select a photo in another 
application or in Safari and copy it using the context menu. You can then insert it as a new product 
photo using the “Paste” icon. 

Copy or export product photo 

The product photo can be copied using the “Copy” icon. 

The product photo can be dragged and dropped into other applications or the Finder. 

The product photo can also be exported in various formats. To do this, select “Save picture” from the 
context menu and choose the appropriate format. 

The product photo can be removed using the “Remove” icon. 
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A D D  A D D I T I O N A L  P I C T U R E S  

You can add as many additional pictures as you like to an entry. To do so, click on the “Multi Picture” 
icon. 

In this new window, you can add pictures using drag and drop. To do this, drag any picture into the 
“Drop picture here” area. You can add pictures via a Finder dialog using the “+” button. The selected 
picture can be deleted using the “-” button. 

Sort 

The additional pictures can be sorted as follows: 

• File name 
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• Created on 

• Modification date 

• Manually 

To do this, select the appropriate sorting option from the menu. 

When sorting manually, the sorting can be set by clicking on the “Sorting” icon. 

In the following window, sorting can be done using drag and drop. 

Delete sorting 

An existing sort can be deleted. To do this, click on the “Delete sorting” button. 
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A D D  P R O D U C T  P I C T U R E  O R  AT TA C H M E N T S  V I A  I O S  
D E V I C E  

A product photo or attachment can be added to each entry. To do this, click on the iOS import icon. 

The following options are available for import: 
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D U P L I C AT E  E N T RY  

To duplicate an entry, select a clock from the list and click on the “Duplicate” icon in the toolbar menu. 

A copy will be created in front of the selected entry and the details view will open. The name of the new 
entry will be “Old name COPY”. 

In the settings, you can specify whether pictures and attachments should also be copied. 
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A D D  O R  R E M OV E  E N T RY  F R O M  FAVO R I T E S  

To add an entry to your favorites, select a clock from the list. In the details, you can add or remove an 
entry from your favorites using the “Add to favorites” switch. 

NOT included in favorites 

Included in favorites 

Alternatively, you can also do this via the menu or the context menu. 

Context menu 

To add an entry to your favorites, you can also drag and drop it from the list of watches to the “Favorites” 
section. 

To add an entry to your favorites, you can also drag and drop it from the list of watches to the “Favorites” 

section. 
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You can also remove items from your favorites using drag and drop. To do this, drag an entry from the 
list of watches to the “My Watches” section. 
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A D D  O R  R E M OV E  E N T RY  F R O M  W I S H  L I S T  

To add an entry to your wish list, select a clock from the list. In the details, you can add or remove an 
entry from your wish list using the “Add to wish list” switch. 

NOT included in wish list 

Included in wish list 

Alternatively, you can also do this via the menu or the context menu. 

Context menu 

To add an entry to your favorites, you can also drag and drop it from the list of watches to the “Favorites” 
section. 

To add an entry to your wish list, you can also drag and drop it from the list of watches to the “Wish list” 
section. 
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You can also remove items from your wish list using drag and drop. To do this, drag an entry from the list 
of watches to the “My Watches” section. 
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A D D ,  R E N A M E  O R  D E L E T E  AT TA C H M E N T S  

To add, rename, or delete an attachment, click on the attachment icon to the right below the product 
image area in the details. 

The red indicator dot shows whether the selected entry has attachments or not. 

No attachments available 

Attachments are available 

The “Attachments” window opens. 
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The following features are available:

To add an attachment, simply drag a file from the Finder into the Attachments window, or click on the 
“Add Attachments” icon at the bottom left. 

To rename an attachment, select an attachment and click on the edit icon at the bottom left. Or select 
“Rename Selected Attachment” from the context menu. 

A preview of each selected attachment can also be displayed. To do this, select an attachment and press 
the space bar on your keyboard. Pressing the space bar again closes the preview. 

Attachments and folders can be moved to a folder using drag and drop. 

Create folders / subfolders

Add attachment

Rename attachment / folder

Delete attachment / folder
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A D D  AT TA C H M E N T S  V I A  I O S  D E V I C E  

You can also add attachments using the camera on an iOS device. To do this, click on the iOS import 
icon. 

Select the “Attachment” option. 

The attachments are added in the attachment management section. 
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S H A R E  E N T RY  

To share an entry about the services available in the system, first select an entry by double-clicking on it. 
Now click on the share icon. 
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M OV E  E N T RY  T O  T R A S H  O R  R E M OV E  E N T RY  F R O M  T R A S H  

If you no longer need an entry, you can simply place it in the trash via the toolbar menu, the menu, or 
the context menu. If you need it again later, you can retrieve the entry from the trash.. 

Alternatively, you can also drag and drop an entry into the trash. To do this, drag an entry from the list of 
watches to the “Trash” section. 
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To remove an entry from the trash, simply drag it to the “My watches” section. 

This can also be done via the context menu “Remove from trash”. 
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D E L E T E  E N T RY  

Um einen Eintrag zu löschen, wähle einen Eintrag aus der Liste aus und wähle im Menü oder 
Kontextmenü "Eintrag löschen". 

When deleting an entry, all pictures, attachments, and all customer service entries are deleted. 

This action cannot be undone! 

© 2015-2025 CIMSoft, @pps4Me            Table of Contents Page  of 33 58



My Watches Release 25.1.0

S E A R C H  E N T R I E S  

You can use the search field to search for specific watches or filter the watches displayed. 

Enter the term you are looking for or part of it. The search will start immediately as you type. You can use 
the menu in the search bar to specify how the search should be performed. 

The default setting is to search for “name contains.” 
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M A N A G E  C AT E G O R I E S  

To manage categories, click on “Tools => Manage categories” in the menu. 

Or select the “Manage” icon and “Categories” from the toolbar menu. 

The “Categories” window opens. Here you can add, rename, or delete categories. 
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Search category 

To search for a specific category, enter the search term in the “Search” field. The default search is always 
“Starts with.” 

Rename category 

Select a category from the list and change the name. 

Delete category 

Select a category from the list and click on the “Delete” icon in the toolbar menu. 

Categories that are still in use cannot be deleted. 
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M A N A G E  M A N U FA C T U R E R  

Select “Tools => Manage Manufacturers” from the menu to access the manufacturer management 
screen. Alternatively, click on the ‘Manage’ icon in the toolbar menu and select “Manufacturers”. 

The “Manufacturers” window opens. Here, manufacturers can be added, renamed, or deleted. 
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Search manufacturer 

To search for a specific manufacturer, enter the search term in the “Search” field. The default search is 
always “Starts with”. 

If you want the search to be performed with “Contains,” place a % sign before the search term. 

Add manufacturer 

Click on the “Add” icon in the toolbar menu and enter the name of the manufacturer and other details. 
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Edit manufacturer 

Select a manufacturer from the list and modify the corresponding fields. 

Delete manufacturer 

Select a manufacturer from the list and click on the “Delete” icon in the toolbar menu. 

Manufacturers that can still be used cannot be deleted. 
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C H A R T S  

The increase in value can be evaluated using a graphical overview. To do this, select “Extras => 
Evaluation” from the menu or click on the “Evaluation” icon in the toolbar menu. 

1. Save as 

2. Select category 

• All watches 

• Own watches 

• Sold watches 

3. Select the number of entries per page 

4. Select page 
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The charts can be saved in the following formats using the “Save as” icon in the toolbar menu: 

Pixel format 

• BMP 

• GIF 

• JPG 

• JP2 

• PNG 

• TGA 

• TIFF 

• WebP 

Vector format 

• PDF 

• SVG 

© 2015-2025 CIMSoft, @pps4Me            Table of Contents Page  of 41 58



My Watches Release 25.1.0

S TAT I S T I C S  

The increase in value can be evaluated using a graphical overview. To do this, select “Extras => 
Statistics” from the menu or click on the “Statistics” icon in the toolbar menu. 

The statistics can be evaluated for the following areas: 

• All watches (own watches and watches sold) 

• Own watches 

• Sold watches 
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Die Wertsteigerung kann über das Symbol “Teilen”, mit allen im System verfügbaren Teilen-Dienste, 
geteilt werden.  
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P R I N T  A L L  WAT C H E S  

To print a list of all watches, select the “Print” icon in the toolbar menu. Now select “All watches” from 
the menu. 

The print window will now open. Here you can see a preview of the printout, which you can change 
using various options. 
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By clicking on “Options,” the following settings can be changed: 

To change the logo, simply drag a file from Finder into the logo area. 

The print preview can also be saved directly as a PDF or HTML file. To do this, click on the 
corresponding icon in the toolbar menu. 
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P R I N T  V I S I B L E  WAT C H E S  

To print a list of visible watches, select the “Print” icon in the toolbar menu. Now select “Visible watches” 
from the menu. 

The print window will now open. Here you can see a preview of the printout, which you can change 
using various options. 
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P R I N T  A L L  WAT C H E S  W I T H  A L L  D E TA I L S  

To print out the details of all watches, select the print icon in the toolbar menu. Now select “All watches 
with details” from the menu. 
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P R I N T  V I S I B L E  WAT C H E S  W I T H  A L L  D E TA I L S  

To print the details of all visible clocks, select the print icon in the toolbar menu. Now select “Visible 
clocks with details” from the menu. 
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E X P O R T  A S  C S V  F I L E  

To export all data as a CSV file, select “Export as CSV file” from the menu. 

Various export parameters can still be set. 

CSV preview 
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E X P O R T  A L S  X L S X  DAT E I  

To export all data as an Excel® XLSX file, select “Export as XLSX file” from the menu. 

XSLX export file in Excel®: 
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S E T T I N G S  

The settings are accessed via the menu. 

View 

Duplicate 
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Print 

Export 

JPG 
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JPEG2000 

WebP 
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B A C K U P  A L L  DATA  

You can use the backup feature to back up the database and all attachments from “My watches.” To do 
this, select “Back up all data” from the menu. 

Select any data carrier/folder. A folder named “My Watches” will be created in the selected folder. The 
database, pictures, and attachments will be saved in this folder. 
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R E S T O R E  A L L  DATA  

You can use the restore feature to restore the ‘My Watches’ database. To do this, select ‘Restore all data’ 
from the menu. 

Select the folder containing the backup data for “My Watches.” All data and the database will now be 
restored and reloaded. If the selected folder does not contain any backup data for “My Watches,” this 
error message will be displayed. 
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H E L P  M E N U  

The following features are available in the ‘Help’ menu: 

M O R E  A P P S  F R O M  @ P P S 4 M E   

Click here for more apps from @pps4Me. 

C O N TA C T  T O  U S  

If you still have unanswered questions, please send us an email at Contact@Support. Or visit our 
homepage. 
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C O P Y R I G H T  &  G E N E R A L  T E R M S  A N D  C O N D I T I O N S  

General Terms and conditions for the use of this help book.  

I. Right-holders, copying, Copyright  

1. The copyright of this help book is by CIMSoft, pps4Me, Horst Jehle, Bahnhofstraße 21, 71063 
Sindelfingen, Germany (hereinafter referred to as "author"). The Copyright refers to the graphics, the 
text as well as the electronic source text to graphics and all texts as a whole. 

2.  In the source text of the template (template) is the copyright of the author. This Copyright notice © in 
the source text of the manual must not be removed. Already the removal of copyright constitutes 
copyright infringement and may be punishable by law. 

Add your own copyright notice is not permitted.  

3. The provision of this manual with download option on their own or third party websites, the 
reproduction and copying to CD's/DVD's or other data carriers for the purpose of disclosure to third 
parties both paid and free of charge (except for personal use) as well as a direct link to the download 
files is prohibited.  

4. With the download of this manual, the user acknowledges the terms and conditions of use.  

II. Free private use  

1. This help book is free to personal, private, non-commercial purposes.  

2. With the download of this manual, the user receives the right to use the manual for the purposes of 
this Terms of use. The property rights in the content fully remain with the author.  

III. Commercial pay use  

1. Commercial and thus pay use for the purposes of this Terms of use is when to book a private or third 
acquisition business regardless of the size advertised in any way, pay services under a single URL 
provided.  

IV. Scope of the commercial use  

1. The use of this help book is only permitted for a company. The right of use expires with the use at 
another company or a subsidiary or parent company. The right of use is each registered Company to 
acquire new or pending business. 

2. With every purchase of the manual is the internet address (URL) under the manual goes online  

3. For any use in accordance with Section IV of the terms of use is a one-time fee for usage numbers. 
The amount of the remuneration of utilisation can be requested via E-Mail.  

4. Upon payment of the one-time usage fee, the user merely acquires the right of use within the 
meaning of these Terms of Use. Ownership of the manual remains with the author without restriction.  

5. With one-time payment of the remuneration of utilisation of the user acquires only the right of use for 
the purposes of this Terms of use. The ownership of the manual fully remains with the author.  

6. Any commercial user will receive a VAT invoice.  
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V. Copyright Infringement  

1. Any copyright infringement will be prosecuted. The author, a lawyer will always help. Be asserted in 
the context of provisional legal protection - if necessary - injunctive-, information- and claims for 
damages.  

2. A copyright infringement is if the manual with criminal content by the users or by third parties. The 
author is displayed next to the assertion of civil claims immediately after having regard to criminal 
report.  

3. Responsible in the sense of the UrhG and these terms and conditions, in addition to the owner of the 
company or the industry for non-existing persons identity of the creator of the website using this book is 
offered for download or in any other manner.  

4. Information about the legality of a planned use of the book given by the author. The contact data the 
author can bee seen in the imprint on the web page.  

VI. Liability  

The author assumes no liability whatsoever, regardless of the legal grounds, arising out of the use and/
or the use of the book or in any other way in connection with the acquisition, exploitation and use of the 
book could be deducible, except in cases of intent or gross negligence. 

The brand names used in this manual are registered trademarks of their respective owners.
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